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Training Thresholds

Training Thresholds are used in conjunction with a Training BioGauge in the
context of a Workout.

[T =]
S o | [— = ' -Ei- L]
- - - Harker 1 =Ry

LZI0PM / DO TAR

Threshold targets are set in Preferences > Training Thresholds.

Training Threshelds

Motify Based On: @ Individual - CTRI) Team Average

Team Phy Load Mech Load Training Load
Zephy 0 0 0
Team A 0 0 ]
Team B 0 0 ]

When the prescribed targets are met (individually, or team average), the

subject name and target met will flash in a contrasting color on their Training
BioGauge, either individually or as a team, dependent on the Notify Based On

setting.
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SYSTEM OVERVIEW

SYSTEM SETUP
Speed Zones

Speed zones can be configured for subjects who are using a supported GPS
device in conjunction with their BioModule.

> Startup Sequence

> Live Screen Overview

BioG - - Backgrouna Shading (1 P [
> BioGauge eliSpeed ROG [ | Training Zune Positional Error 15 ‘|
01:4250 1323 Horizontal Axis '

> Side Tabs 16:45:16 |@ Real Time © Elapsed Time | Export |

> Map Window
> Session Names & Markers 3 = Rl | 1l =

> Notification Area 3

> Connection to Cloud Portal

>Demo Mode

ANALYSIS OPERATIONS
ANALYSIS IMPACT
PROCESSING
ANALYSIS REPORTS
LOG DATA
OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE T T
el S B oo * InOmniSense™ Analysis, select the check box above the time graph to
BASELINE FITNESS TESTING show speed zones as background shading. lllustrated is speed over time in
FITNESS PARAMETERS miles per hour over a cycle run tracked by GPS.
APPENDICES
EULA = Aslower limits are adjusted, the upper limit for each zone adjusts
SUPPORT automatically.
INDEX 4 Preferences ==

(G setman) | | P

[Wakes | 177 kph - Greater

‘Ml 1448 kph - 17.69 kph

[Gauge Setirgs__| Speed Zone 4: 127 kph - 1447 kph

[Safety Thresholds | 8.05 kph - 1126 kph

[ntersty8load | | E 483 keh - 804 keh

Less Than 482 kph

| Training Thresholds |

Tr Zor
(Tring Zones | Configurable Speed Zones can be used when compatible Blustooth GPS

Speed Zanes units are included with the system for tracking how much time and

distance subjects spend in each zone. For more information contact
[Workouts | | |soles@zephyrammhere com

Defautt

[ Save || Cancel |

= Speed Zone datais not viewed in OmniSense™ Live, but in the Analysis
module.

Note

When logging GPS data internally in a BioModule, it must be configured to login
Summary and Waveform or Enhanced Summary and Waveform format, using
the Zephyr™ Config Tool.
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SYSTEM SETUP -
Connection to Cloud Portal

= Aninternet connection is required.

> Startup Sequence

> Live Screen Overview = Both OmniSense™ Live & Analysis can connect to the OmniSense™ Cloud
> BioGauge Portal.

> Side Tabs =  When OmniSense™ Live is connected, streaming live data is automatically

> Map Window uploaded to the portal and can be viewed remotely. Data is only uploaded
> Session Names & Markers for those subjects who are registered with the portal.

> Notification Area « Theregistration process is described in the OmniSense™ Web Portal

> Preferences section.

=  When OmniSense™ Analysis is connected, any log data imported from

D Mod . . . .
- Demotiode BioModules assigned to registered portal users is also uploaded.

ANALYSIS OPERATIONS

ANALYSIS IMPACT 1
PROCESSING ’

ANALYSIS REPORTS
LOG DATA ! |

OMNISENSE™ WEB PORTAL

Click on the connect button on the Live (or Analysis) toolbar.

OMNISENSE™ MOBILE 2. Enter your User Name and Password. The user name will have been

assigned to you, and password set by you as part of the registration
OMNISENSE™ TOOLS

process.
BASELINE FITNESS TESTING

Lagin @
FITNESS PARAMETERS
User Name: [ZephyrDemoAdmin|
APPENDICES
EULA Password:
SUPPORT Account Number:
INDEX Logged-Out Remember Me
Login Close
Click Login.

3. Thetoolbar button will toggle to show the application is connected to the

web portal.
=]

@ Note

No data is ever downloaded from the portal to a local OmniSense™ Analysis
instance. It can only be viewed in the portal itself.

However, subject physiological parameters such as maximum heart rate,
fitness level etc - are synchronized between the web portal and a local PC
instance every time they are connected, to maintain integrity of these
parameters.
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SYSTEM OVERVIEW

SYSTEM SETUP
Demo Mode

e Demonstration mode exists for training and demonstration purposes. It
consists of a number of subjects displaying virtual data.

> Live Screen Overview
> BioGauge * No LoRa Gateway needs to be connected to operate in Demo mode.

> Side Tabs » IfalLoRasystemis active, then real subject data will display at the same

> Map Window time as the virtual subjects.

ion N [ .
> Session Names & Markers = Engage Demo mode using the toolbar button.

DM

> Notification Area
> Preferences

> Connection to Cloud Portal

= 21 virtual subjects will display, on 3 team tabs: Goalkeeper / Defenders /
ANALYSIS OPERATIONS Offense.

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS
LOG DATA

[TE T =
(]

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS

BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

16 Midfielder [17 Midfieider (L (LR Ly 19 Midfielder
mr 6.8 | i 57 [eaFA L 7
L Load-T| 12 Load-T [Tt Ry | % |oad-T

Demo Subject 1
wr 0.0
Loagp LOAD-T

L229PM J G00IML

Training tab
All tabs and Standard or Training BioGauges will function, except for:
= Acceltab
= GPStab

=  Workouts - the Workout tab can be viewed, but subject data will not
attempt to match the Workout targets.

103




CONTENTS

ABOUT THIS MANUAL OMNISENSE™ LIVE OPERATIONS

GETTING STARTED Demo Mode (2/2)
SYSTEM OVERVIEW

SYSTEM SETUP
Demo Team Setup

In Demo mode, the subjects exist in all the setup tabs. Subject parameters can
be edited, and subjects removed from teams or teams un-deployed as real
subjects would.

> Startup Sequence

> Live Screen Overview
> BioGauge
> Side Tabs No hardware is assigned to the demo subjects. They are assigned files of virtual

> Map Window data. These files can be selected from arange of options.

> Session Names & Markers Forward

< |

- L] 11 =
b[\ﬂfg(ﬁ%ﬂg%\ﬂ%&&fnwulatfon
A
RSO e mulaton

"Beeplestl simulation”
bFfmu L nfe

"Beeplest? simulation”
bFfmu auorH1 e

> Notification Area Forward

< |

> Preferences Forward

< |

> Connection to Cloud Portal Forward

=

Forward

=

Forward

=

ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA 1. Thesimulation files can be assigned exactly as devices, by selecting the
demo subject, and using the Assign button in the Setup > Hardware tab.

"Beeplest3 simulation”
bFfr_nu auon fe ) )
b[\;1 rﬁ(ﬁgﬁgﬂ\ﬂ}gl simulation

Forward

< |

Forward

< |

MixedActivity3.simulation”

OMNISENSE™ WEB PORTAL

OMNISENSE™ MOBILE 2. ASelect Hardware Components dialog will display, with an additional

Simulation tab.
OMNISENSE™ TOOLS

BASELINE FITNESS TESTING Select Hardware Components =
FITNESS PARAMETERS 11 Forward
APPENDICES |Hard$|

Simulation Files\Beep Test2 simulation
Simulation Files\Beep Test 3 simulation
EULA Simulation Files'\Fireman Test 1 simulation
Simulation Files"Fireman Test2 simulation
Simulation Files'\Fireman Test 3 simulation
SUPPORT SimulationFiles \Fireman Test4 simulation
Simulation Files"Fireman Test5 simulation
SimulationFiles'\Fitness Test simulation
INDEX Simulation Files\Mixed Activity 1.simulation
Simulation Files\Mixed Activity 2 simulation
Simulation Files\Moxed Activity 3.simulation

Beep test, fitness recording sample 1

Selections

Assign || Clear | ‘ Cancel

3. Whenafileis selected, a note below will describe the nature of the data,

4. Click Save to assign the simulation file.
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Overview

OmniSense™ Local PC Database

= Both OmniSense™Live and OmniSense™ Analysis send and receive data
from and to the OmniSense™ Local PC database.

OmniSense™ Local
PC Database

Zephyr™

Downloader @

Logged Data

OmniSense™ Live OmniSense™ Analysis

The database repository is a single file, polling.fdb, located at
C:\Program Files (x86)\Zephyr\OmniSense\Database\DbFile.

At each upgrade install, the existing database is backed up before a new
instance is created and populated with any existing data.

The database contains:
= Allsubject & team data.
= All device data and who devices are assigned to.

= Allsession data.

The database is populated by:
= Receiving streaming data via LoRa from OmniSense™ Live.
* Importing BioModule Log data via OmniSense™ Analysis.

= Importing external .zsf session files from another instance of
OmniSenseTM Analysis, or previously archived from the current instance.

@ Note

The database file is secure and cannot be opened directly - it can only be
accessed via OmniSense™ Analysis. However, it can be copied and substituted
into the same location in a second PC. All data will be transferred.
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Features

E = =

Time graphs Summary graphs

Filter Sessions By

= Team, Subject

= Session Name

= Subsession Name
= Time/Date

Manage Sessions

= Export, rename, move, delete &
archive

Time Graphs

= Show 2 parameters of 46 available

= Automatic & Manual Fitness
Testing analysis

= Real orelapsed time

= ROG Status, training or speed
zone background colors

= Subsessions

Fitness & Training Reports

= Compare individual against
normative or team data

= Mean & Std Dev

= Table &radar plot format

= Group Consolidated Summary

= Periodization Report

= Summary GPS

= Summary Physiological

= Workout Compliance

E =
E (]

Reports Impact Reports

Legend

= Compare up to 16 color-coded
sessions simultaneously

Export Graph Data

= Multiple file and image formats

Summary Graphs

= Show 2 parameters of 46 available

= Min/Max/Avg/Total displayed as
bar graphs

Impact Reports

= 5 configurable impact zones by g
force

= Basedon 100 Hz 3-axis data
= Summary impact counts per zone

= Magnitude, duration & direction of
impacts

= Automated grouping of impacts

by type

= Walk

* Run/intense run

= Bound/Jump

= Detailed analysis showing peak
g, rise time, duration, rate of
force development & decline
and total impulse load
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Physiological Parameters

The following parameters are available in addition to those displayed in

OmniSense™ Live.

Parameter

Units Description

From Fitness Test Analysis

HR @ AT Beats/minute From detection of Anaerobic Threshold
BR @ AT Breaths/minute From detection of Anaerobic Threshold
VO,max ml/kg/min Based on heart & breathing rates
HRmax Beats/minute Maximum heart rate of subject

BRmax Breaths/minute Maximum breathing rate of subject

Heart Rate Recovery

Beats per 30 sec | On cessation of test, subject stationary

%VO,max @ AT

%VO,max Accepted performance indicator

Fitness Level

Max, Min, Average

Scale1-10 10 = elite athlete
From Summary Graphs

All parameters

2nd, 9th, 25th, 50th, 75th,91st, 98th,

Speed Box Plot
pee ox o 100th percentiles
. 2nd, 9th, 25th, 50th, 75th,91st, 98th,
Elevation Box Plot .
100th percentiles
Jump time in air Seconds Based on jump detection

Jump height Feet / meters Based on jump detection
Exercise Time Duration
Time above AT Duration

Time in HR Zones

% Total Duration | Banded histogram - % time in each zone

Time in Training Zones

% Total Duration | Banded histogram - % time in each zone

Time in Speed Zones

% Total Duration | Banded histogram - % time in each zone

Distance in Speed
Zone

% Total Distance | Banded histogram - % time in each zone
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Physiological Parameters

Parameter

Units

Description

From Reports (Group Consolidation Report contains all)

Average Value

Of all parameters in report

Standard Deviation

Of all parameters in report

Significantly Low
Value

Less than 1 STDDEV below average

Significantly High
value

More than 1 STDDEV above average

% Time in HR Zones

% Total Time

Time in various zones

% Time > HR@AT

% Total Time

Time operating above Anaerobic
Threshold (AT)

% Time < HR@AT

% Total Time

Time operating below AT

Peak HR

Beats/minute

For the session

Average HR Beats/minute For the session

Average, Max HRV ms (STDDEV) Average, Max in milliseconds

Average, Max HRR Beatsin 30 Subject stationary for 30 seconds
seconds

Average, Max Core DegreesC/F For the session

Temp

Time in Training . Blue/Green/Yellow/Orange/Red
Duration

Zones zones

Time in Speed . Purple/Blue/Green/Yellow/Orange/
Duration

Zones Red zones

Distance Miles/km Distance in above zones

Average, Max Speed

Miles or km per
hour

For session

Elevation Climb,
Descent

Feet / meters

Total climb & descent for session
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Demonstration Data

A number of demonstration sessions are available in every OmniSense™
installation which can be used to familiarize yourself with how Analysis works.
Some sessions include GPS data which can be displayed on Google Maps™*
within Analysis.

> Sessions

> Subsessions
These sessions are all dated in the year 2001. They will only become visible if

> Graph Types X i i
) the From date field is edited to start from this year.
> Time Graphs
o To:
> Summary Graphs e
ybrap I 01 Jan EliE, 00:00 [~ I 01.Jan 2010,00:00 [E~
> Graph Functions
Select Session Drag Up to 16 onto Legend
> Print / Export ~ ] Zephyr g
> Data Filters = Subject01 Demo
- {2 Demo Heart Rats Recovery / [27 Jul 2001 - 13:39:35] / [00:58:57]
> GPS Data {2 Demo BP Sp0O2 (Mo Activity) / [12 Aug 2001 - 14:37:16]/ [01:03:57) |2
) = @ mountain biking race / [16 Sep 2001 - 09:54:05]/ [00:31:09] { GPS )
> Readiness 7
. L startLap/[10:00:51 = 10:23:27]/[00:22:35]
ANALYSIS IMPACT = @ mountain biking race / [16 Sep 2001 - 12:04:10]/ [00:26:17] { GPS )
PROCESSING o L@ Lap/[12:09:08 -= 12:28:15]/[00:19:07]
= @ mountain biking race / [16 Sep 2001 - 14:22:16]/ [00:19:43] { GPS )
ANALYSIS REPORTS ¢ L@ Lap/[14:2218 = 14:41:34] 1 [00:19:16]
= @ mountain biking race / [16 Sep 2001 - 16:36:37]/ [00:20:56] { GPS )
LOG DATA ¢ L@ Lap/[16:36:39 = 16:55:49]/[00:19:10]
- = @ mountain biking race / [16 Sep 2001 - 20:19:26] / [00:48:21] { GPS )
OMNISENSE™ WEB PORTAL s L@ Finish Laps - 2/[20:19:30 == 21:03:15]/[00:43:45]

= @ 5 Mile Run /[16 Nov 2001 - 17:07:29] / [01:00:28] { GPS )
@ 1stMile | [17:16:48 -> 17:24:49]/[00:08:01]

OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS

The sessions are:

Subject Session

Demo Heart Rate Recovery

APPENDICES

EULA
SUPPORT Demo Blood Pressure*/Blood Oxygen*

INDEX Subject 01 Demo Mountain bike race x5 with subsessions (GPS)

5 mile run with mile subsessions (GPS)

Readiness Assessment

Beep Test

Soccer Practice
Treadmill Test

Subject 02 Demo

5 mile run with mile subsessions (GPS)

Beep Test

Subject 03 Demo Soccer practice

Treadmill Test

Beep Test
Subject 04 Demo

Soccer Practice

Dash Test x 2
Subject 05 Demo Jump Test x 2

Soccer Practice
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Database Rules

Select Session Drag Up to 16 onto Legend
5.7 Zephyr
5-[23 Zephyr Demo
—@ Circuit 47 /[22 Mov 2018 - 11:18:35] 1 [00:04:45]

= Subject names must be unique (no duplicates)

= The hierarchy for displaying session data in OmniSense™ Analysis is

» Team Name (or No Team Assigned)
= Subject Name
= Session Name
= Subsession Name

= Subjects are listed under the last team they were assigned to.

= Ifthe subject has never been assigned to a Team (this is possible if log data
isimported), they are listed as ‘'No Team Assigned'.

= Team names can be deleted and recreated as necessary.

= Sessions can be Archived —they are saved as an external .zsf file, and are
deleted from the database. The external .zsf file can be re-imported at will.
Use this function to 'de-clutter’ a database and speed up database loading

time.
Select Session Drag Up to 16 onto Legend
=11 Zephyr
—-] Zephyr Demo
_0
@ Subsessig Rename
Export To Z5F
Export GPS Data To KML File
‘ Archive All Filtered Sessions To Z5F
Delete
Delete All Filtered Sessions
Copy Sessions To 3
Copy Subsessions To 3
Create Subsession
Caution

If a subject is deleted from the database, all of their sessions are deleted
and cannot be recovered. If you re-use the name, you will be prompted to
‘reactivate’ a deleted subject, but their old data will no longer be available.
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> Sessions

> Subsessions

> Graph Types

> Time Graphs

> Summary Graphs

> Graph Functions

> Print / Export

> DataFilters OmniSense™ Live OmniSense™ Analysis
> GPS Data

> Readiness
= Datamust be recorded in the Live module (or logged internally in
ANALYSIS IMPACT

PROCESSING BioModules) for later display in the Analysis module.
ANALYSIS REPORTS = Recordingis the default state when Live mode is engaged.

LOG DATA » The default Session Name in Analysis will be Live, unless the sessionis
OMNISENSE™ WEB PORTAL renamed in Live, or renamed later in Analysis.

el AT Ao = Analysis and Live modules can run simultaneously, but data must be
OMNISENSE™ TOOLS regularly refreshed manually in the Analysis module using the Refresh
BASELINE FITNESS TESTING button.

FITNESS PARAMETERS Q

APPENDICES

EULA

SUPPORT ‘ —— ﬁ
INDEX

Smdi

Select Session

T‘\'eccrding Start hh:mm:ss )

Duration hh:mm:ss

= Each time the Record button is toggled off/on in a continuous session
in the Live Module, new individual subject sessions are created in the
database for each subject deployed.

= These are displayed as separate subject sessions in Analysis, for each
individual subject.




CONTENTS

ABOUT THIS MANUAL OMNISENSE™ ANALYSIS OPERATIONS

GETTING STARTED Ove rview (8/ 9)
SYSTEM OVERVIEW

SYSTEM SETUP

Analysis Toolbar
LIVE OPERATIONS

o B S

| " gy , il |
r v ERI= =
Horizontal Axis

> Graph Functions = : Map Active l Filter H Export|
Real Time @ Elapsed Time

> Sessions

> Subsessions

> Graph Types Background Shading

> Time Graphs HB“'E vl

> Summary Graphs

> Print / Export

> Data Filters
> GPS Data lllustration is for the Time Graphs toolbar - some items will not appear for
Summary graphs.

> Readiness
s
ANALYSIS REPORTS Show Time graph
LOG DATA
OMNISENSE™ WEB PORTAL Show Summary graph

OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS

Show Readiness graph

Offline (left)/Online (right) Web Portal
connection

APPENDICES
EULA

Preferences

lE]mElI]E]?I

SUPPORT
INDEX

Start Impact Processor utility

h.l

==

=
&

Import zsf file/BioModule log file

Refresh database

Help

Remove all session markers

Add a session marker

Create a subsession

a3 I 9]+

Open Map pane/window

Ve

Show graph full screen

Print

Clear all graph data

ELE
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Background Shading Set background shading of graph to
|Hone v| None/ROG Status/Training Zone/Speed
T Zone/Positional Error
> Sub. i . .
Gu S:Tlons HDHZDTtTa'I Axis . Show horizontal axis as real (absolute)
rapn ypes cal Time @ Elapsed Time time or elapsed time (starts at 00:00:00)
> Time Graphs
> Summary Graphs | Filter | Apply conditional filter to data
> Graph Functions
> Print / Export | Export | Export graph contents as csv or various
> Data Filters graphical outputs

> GPS Data
Note

> Readiness
ANALYSIS IMPACT Markers, when added to a session, are exported when the output format is

PROCESSING graphical e.g. pdf, jpeg etc, but not when the output is csv file format.
ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX
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Custom Session names make for easy filtering of data for display in Analysis.

> Overview Session Naming in OmniSense™ Live

> Subsessions

> Graph Types

> Time Graphs
> Summary Graphs
> Graph Functions

> Print / Export

> Data Filters

> GPS Data

> Readiness
= Create a Session Name in Live > Preferences and name using the Change
ANALYSIS IMPACT

PROCESSING Session Name button
ANALYSIS REPORTS
LOG DATA

. e e . ™ .
OMNISENSE™ WEB PORTAL Session Name Filtering in OmniSense™ Analysis

OMNISENSE™ MOBILE

OMNISENSE™ TOOLS P —— ,
v

BASELINE FITNESS TESTING o

FITNESS PARAMETERS

20 May 2008 s 0B !

iSelect Session ol
i = ‘4 Alpha Team ,

APPENDICES i) = gyt .
; (@ Mixed Activity  [06 May 201§
EULA : i

SUPPORT
INDEX

= Use the Show Sessions filter to easily locate a named session.

Set Session Name in Zephyr™ Downloader

E Zephyr Downloader - (1 devices)

Eile View Options

Team Data Download

1. Select Team -
2. Retrieve Team / Subject Combo

3. Select Session Range - Start 00:00:00 - Tue 21 Apr 2015

N 4. Session Name Moced Activity]

5. Download Team Sessions

= Set the Session Name when importing log data using the Zephyr™
Downloader.

@ Note

Sessions can be renamed at any stage in OmniSense™ Analysis by right-
clicking on the session and selecting Rename from the context menu.
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> Overview 2ot . prerrr—— LT lrllnlmhpﬂnmm
e — = pri— |t = £ L Y00 - A
> Subsessions i i Fr—— Mo R B — oty

> Graph Types

> Time Graphs

> Summary Graphs

> Graph Functions . ““T""‘“ i ]"". ,-"/\'1 ;,:/I RVA Y vAl
> Print / Export ZL:W,::.:.“.. S i IV | f "
Wechanical Loag i, H nal S PUTID B2
> Data Filters :"".""::‘I':,":"““ --s:-:“:' _:._f,“ ..‘9“ . P .ﬁ""':ﬁ‘ "‘.__."9 . o
-GS Traininsg kntenatty = b = i
ata FiTesmtTins e
> Readiness :;:2;.". Tost il 'E'mﬁz&ﬁgﬂhwmvmh
ANALYSIS IMPACT Fi
PROCESSING S -
ANALYSIS REPORTS
LOG DATA 1. Select graph type using the appropriate toolbar button
OMNISENSE™ WEB PORTAL . .
Time (Line graph) Summary (Bar graph)
OMNISENSE™ MOBILE E o
OMNISENSE™ TOOLS i

BASELINE FITNESS TESTING

FITNESS PARAMETERS 2. Ifareportis needed, rather than a graph, select the appropriate tab. Refer

to the Analysis Reports topic.
APPENDICES

EULA
SUPPORT

INDEX 3. Usefilter pull downs to populate the Select Session tree. The From date
defaults to 14 days before the current date. This is configurable in
Analysis Preferences.

Training Reports | Fitness Reports

E Preferences

General Application Settings

|W| Display Units in Eatric -
|W| I Session From/To Duration (days) [ﬂ— Days I
|SpeedT| Smooth Bad Location Data

4. Draganddrop, or double-click sessions to populate the Legend.

5. Select 2 parameters to display on a graph (3 parameters are automatically
displayed for Treadmill or Beep tests).

@ Note

When selecting parameters, the first parameter selected units display on
the left-side vertical axis. If either parameter is de-selected, the remaining
parameter’s units will display on the left side vertical axis.

If a third parameter is selected, the second selected parameter displays on the
left side axis, and the third on the right side. The first parameter selected is
automatically de-selected.
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> Overview Filter Session List kolate the sessio
Filter by Team Show Teams: Show People: . .
| Zephyr - | Zephyr Demo User - |- Filter by subject
> Subsessions Show Sessions: Show Subsessions:

Filter by [ Impact Test - | Al - Filter by
> Graph Types Session Name From: To: Subsession
> Time Graphs 16 Jan 2013 I~ 16 Jul 2013 I~ Name
> Summary Graphs Select Session

q ] Zephyr
> Graph Functions ) Zephyr Demo User
> Print / Export - (D Impact Test/ (15 May 2013/ 16:45:22)/[00:01:10]
@ Impacts 1[16:46:01 -> 16:46:27]/[00:00:26] g

> Data Filters (D Impact Test/[23 May 2013/ 15:50:35]/ [00:01:30]

> GPS Data

> Readiness
ANALYSIS IMPACT . . . . .
PROCESSING = Effective naming of sessions at the time of recording or download of

logged data will make for faster filtering (using Show Sessions) when
retrieving data.

ANALYSIS REPORTS

LOG DATA
OMNISENSE™ WEB PORTAL = The To date field defaults to midnight on the current day.
OMNISENSE™ MOBILE * The From field defaults to 14 days prior to the current day. This is
IS TICE e erene configurable in Analysis Preferences.
BASELINE FITNESS TESTING Q
FITNESS PARAMETERS
APPENDICES
m Preferences @
EULA
General Application Settings

SUPPORT -
INDEX |W| Display Unitsin: [T -

|W| I Session From/To Duration (days) 14 Days I

| Speed Zones | Smooth Bad Location Data

| Elevation Zones | 0.26 - Distance Tollerance (km})

|

| Summary Graph Smooth Bad Speed Data

@ Note

To access Demonstration data, set the From field to Jan 2001.
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Select Session

The Select Session pane in Analysis displays those sessions which have been
filtered by the Filter Session pane.

Select Session
=] Zephyr
=] Demo Subject3
@
=-{_] Demo Subject4

@ 1[22 Mar 2012/ 11:36:08)  [01:473 v | Demo Subject 3 Soccer Practice /[22 Mar 2012/ 11:36:07]/ [01:47:41]
Soccer Practice / [22 :08] / [01:47:39) » =

Practice /[22 Mar 2012/ 11:36:08] / [01:47:39]
(_] Demo Subject 2 L e :

@ Soccer Practice / [22 Mar 2012 / 11:36:08] / [01:47:38) £l | : Demo Subject2 Soccer Practice /(22 Mar 2012/ 11:36:08] / [01:47:38]

- (21 Demo Subject 5 Demo Subject 5 Soccer Praciice /[22 Mar 2012/ 11.36:08] 1 (01:47:41]

€] Soccer Practice / [22 Mar 2012/ 11:36:08] / [01:47:41]

I.eggnd:

= Click on asession to select it.
» Hold the Control key to multiple select.

= Click and drag a sessions or sessions to the Legend, or double-click to
automatically populate the legend.

Session Options

= Right-click on a Team, subject, session or subsession to display a context
menu of options.

Select Session Drag Up to1 d
D Orthostatic Test/ [22 Oct 2015/ 14:41:09] / [00:50:38) -
0 Circuit 1 GPS 1300 MTB noisy /[22 Oct 2015/ 19:39:55]/ [00:%
] Circuit 1 GPS 1300 MTF ETIVITTRTEYn
@ Circuit 1 GPS1300 MTE ~ Remame
(@) Circuit 1 GPS1300 MTE Export To ZSF
(® Circuit 1 6PS1300/[31 Export GPS Data To KML File
Circ /
D Circult 16PSTS00II3T o ol Filtered Sessions To Z5F
(D Circuit 1 GPS1300/[31
@ Orthostatic Test/ [31 0f Delete
0 Circuit 1 GPS1300 /[31 Delete All Filtered Sessions
(@ circuit 1 GPS1300 MTE Copy Sessions To » Legend
Q) Orthostatic Test/[01 Ny Copy Subsessions To » Report
(D Orthostatic Test/[01 N{ PETn
D Circuit 2 GPS1300 /02 bl :
(@ Orthostatic Test/ [02 N{ Move Session to Ancther Person »
(D Acceleromelry Test/ 03 Merge Sessions
(D Orthostatic Test/[03 Ny Change Time Of Session
s Save Filtered Session
- Raw Physiclogical - '| g
| Heart Rate

Team

Option Description

Permanently delete team, subjects in team, and data
for those subjects.

Permanently Delete

Caution

Permanently deleting a team is a non-reversible action. All subjects in the team
are also deleted, and their data. Teams can be recreated, and subjects, but not
the deleted data, unless it has been uploaded to the web portal. It will still be
available there if the subject is re-activated.
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Sessions (5/5)

Subject

Permanently Delete

Option Description

Permanently delete subject and data (see Caution
on previous page)

Change Team To

Transfer subject to another team, selected from list.
No data is deleted.

Session & Subsession

Rename

Option Description

Rename session

Export to .zsf

Create external ZSF file for import to another
instance of OmniSense™ Analysis

Export GPS data to
external kml file

Export GPS and basic physiological data to a kml file
forimport & display in Google Earth™*,

Archive All Filtered
Sessions to ZSF

Create an external ZSF of multiple sessions. Original
sessions are deleted from database - a dialog will
ask to confirm. This can be used as a means of de-
cluttering the database of unnecessary data.

Delete

Permanently delete the selected session.
Irreversible. Use Archive option to remove from
database, but create an external file.

Delete All Filtered
Sessions

Permanently delete. Irreversible. Use Archive option

to remove from database, but create an external file.

Copy Sessions/
Subsessions to

Legend/Training Report/Fitness Report, depending
which is active on the right-side panel.

Create Subsession

Display subsession dialog, Enter details as needed.

m Create Subsession @

Name: Subsession
Start DateTime 10:55:13 AM 14/Novw/2018 B~
End DateTime 11:32:32 AM 14/Now/2018 B

Apply Subsession To:
@ Selected Sessions Fittered Sessions
Circuit 46

Ok || Cancel

Move Session to
Another Person

Select another subject from pull-down list, in the
event that data has been wrongly associated.

Merge Session

Select sessions which have an overlap (usually
transmitted & log data from the same session). A
new session will be created. No merge is created
if no timestamps overlap in the sessions to be
merged.

Change Time of
Session

Change timestamps of session.

Save Filtered Session

Session Filters must be applied. See section on
Applying Filters to Sessions.
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Subsessions (1/3)

Overview

= Asubsessionis a user-generated section of a parent session, used to
isolate data of interest, or exclude data of no interest so that it does not
show on graphs or in reports.

= Aparent session can have multiple subsessions, and the subsessions may
overlap each other, but you cannot make a subsession from a subsession.
Subsessions display as a sub-node to the parent session in the Select
Session pane.

* The subsession name can be used for easier filtering of data in the Filter
Session pane. Subsessions can be deleted and re-created at will.

Parent Session

::

4

i
CREEER X
i

|Select Session Drag Up te 16 onto Legend
| =2 Zephyr
—] Demo Subject 1
(%) Demo Heart Rale Recovery /|27 Jul 20117 13:39:35]/ [00:58:57]
@) Recovery 1/[1348:32 - 13:56:39]/[00:08:07]

| e SRS ||~ i ]

Caution

If a parent session is permanently deleted from the database, all subsessions
are also deleted.
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Subsessions (2/3)

Subsession by Mouse

1. Display sessions and parameters as needed.

2. Select the Subsession button above graph.

=i

L=

3. Usemouse arrow to click and drag a rectangular frame for the subsession.
Both vertical and time axes will truncate automatically when the

1\.

F
Sansmew e’

EmEEE g

L

i

4. When the mouse buttonis released, a Subsession Name dialog will
display. Select X and redraw the subsession if needed, or OK to create.

A et

Subsession Name :

Sprints

oK |

5. The subsessions will be created in the Select Session tree. If more than
one session is graphed when a subsession is framed, then a separate
subsession is created for each parent session.

E_l Deiried Sl

(D Beep Test! [20 Apr 2012 1 12.47.05] /[00:10:26)
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Subsessions (3/3)

Subsession by Wizard

The subsession wizard is best used where Start

1. (Recommended)Use the Show Sessions fi

and End times are known.

Iter and others if necessary to

display only those sessions you want to use.

Filter Session List
Show Teams:
Show Sessions:
From:
21 Nov 2000,00:00 [~

Select

Isolate the session you want
Show People:

Show Subsessions:

To:

05Dec2018,00:00 [~

Drag Up to 16 onto Legend

=23 Zephyr

.23 Subject 02 Demo

T Socee Pracice 123 ar 2001 112605110 7.3
={3 Subject 03 Demo

T Socee Pracice 122 ar 2001 112607110741
%21 Subject 04 Demo

T Socee Pracice 23 ar 2001 1126081107739
= (2] Subject 05 Demo

1¢/] Soccer Practice /(23 Mar 2001 - 11:36:08]/ (01:47:41]

2. Right-click on a session to display the context menu, and select Create

Subsession.

Select Session

Drag Up to 16 onte Legend

=1 Zephyr
=] Subject 02 Demo

Delete

=3 Subject 03 Demo Rename

- Export To ZSF
={] Subject 04 Demo Export GPS Data To KML File
. ngm 5 Demo Archive All Filtered

Sessions To ZSF

Delete All Filtered Sessions
Copy Sessions To v
Copy Subsessions To »
Create Suk
;R:::g;:iuluglcal Move Session to Ancther Person b b
Braathing Rata Merge Sessians
Skin Temperature Change Time Of Session
Heart Rate Varability Save Filtered Session

- Denendent Phvsioloaical

3. Edit the Create Subsession dialog as needed. Give the subsessions a
meaningful name which can be used for filtering at a later date. Check
Filtered Sessions if all the sessions displayed in the Select Session tree

are to have subsessions created.

m Create Subsession

Name: Circuit Training Day 12
Start DateTime 12:00:00 PM 23/Mar/2001
End DateTime 01:00:00 PM 23/Mar/2001

Apply Subsession To:
Selected Sessions @) Fitered Sessions

Ok Cancsl

==

@~
@~

4. New subsessions will be created for each parent session.

Select Session

Drag Up to 16 onto Legend

=20 Zephyr
=-{Z1 Subject 02 Demo
= 0 Soccer Practice / [23 Mar 2001 - 11:36:08] / [01:47:38]

—._] Subject 02 Demo
= O Soccer Practice / [23 Mar 2001 - 11:38:07]/[01:47:41]

—-[Z] Subject 04 Demo
= @ Soccer Practice / [23 Mar 2001 - 11:36:08] /[01:47:39]

- (2] Subject 05 Dema
= @ Soccer Practice /[23 Mar 2001 - 11:36:08] /[01:47:41]

B ] Circuit Training Day 12 /[12:00:04 = 12:59:59] / [00:59:55],

. ] Circuit Training Day 12 /[12:00:00 = 12:59:58] / [00:59:58]]

B - ] Circuit Training Day 12/ [12:00:01 -> 12:59:59] / [00:59:58]]

B ] Circuit Training Day 12/ [12:00:01 -= 12:59:59] { [00:59:57)]
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Graph Types (1/3)

Select Graph Type
Time Graph

Toolbar button:

Seved Toos 17 PositonsiErer 51 il M

orisontat Ave
feal Time & Elapsed Tighe

= Line graph, two parameters allowed per subject
= Drag vertical cursor to show exact values

= Compare up to 16 subjects

= Leftaxis = 1stparameter selected
= Right axis = 2nd parameter selected - e o e

Summary Graph

Toolbar button:

Legend:
A [ O Sutunct 3 Bacow Prachicn (23 lhar 3013/ 1O |
B [ O ot 3 Sccom Pracacn 177 e 3013/ O

= Average, maximum, minimum or total values, dependent on parameter.
= Show historical trends over multiple sessions

= Compare up to 16 subjects.
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Training Reports

> Overview PSM Training Consolidated Group Report: Group Summary
> Sessions

> Subsessions

> Time Graphs

> Summary Graphs

> Graph Functions

i B Training Reports display a selection of parameters in table format, color coded

to relate each individual's statistics against the mean and standard deviation
for the group. The activity or training session for which the report covers is
> Readiness decided by the user.

9,2‘3'52%'55,}1""{’*“ Aradar plot compares individual subject statistics against the group's.

> Data Filters
> GPS Data
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APPENDICES

EULA

SUPPORT There are five Training report variations:

INDEX «  Group Consolidated Summary (super-set of all parameters)
» Physiological Summary (heart rate related parameters)

» Periodization Report (Intensity & Load Parameters)

= Workout Compliance Report (Training Zone parameters)

»  Summary GPS Report (GPS related parameters - Speed etc)

Fitness Reports

A fitness report compares a subject or team'’s fitness parameters against a
selected normative (elite athletes or user-generated) in table, chart and radar
plot format.

The fitness parameters used are:

= VO,max - HR@ATas%HRmax = HRminResting
= %VO,max @ AT = BR@AT = BRmin Resting
= HRmax = HRRecovery 30 sec = HRV @ Rest

= HR@AT = HR min Standing = Fitness Level

The data used are the subject fitness parameters which have been saved as a
result of fitness test analyses.

Refer to the Analysis Reports section for details.
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Graph Types (3/3)

| [ Comniipnas Anabye 500 =

Filter Session List 8 t s Lagana [T 9] |
Snaw Taoma: Snew beces. = S S b 7t L sl
" - Geaph Training Roports | Fitoess Reports

St Sevnern . Baschground Shading »

Socoer Pracice - “ Fone - _5_ i Al e ‘u

Henizantal Axis e =

e » faad Time ) Elapsad Time Tovee || Beon
14t 3020, 00,3 2 bow 2018

Select Session
2 Zep

wll | 5502 Dama Socoar Prachca [12) hia 2001 -
| 11380000 147)

Soject 03 Dams occar Pracics 1121 hiar 2001 -
NPT Y]

Heart Rate 24T
Heart Rate Recover ot 30sec
Hiar Ratk Reciver of 8024c
Heart Rats Rocovary 2 12008
Haart sty Racivary o 10048

- Acceberometry

o] ey
Fosture
Paak Accaberation

= Click and drag a session to the Legend or
= Double-click the session
= Ctrl+ click to multiple-select

Subject 02 Demo Soccer Practice / [23 Mar 2001 -
11:36:08] / [01:47:38]
Subject 03 Demo Soccer Practice / [23 Mar 2001 -
11:36:07]/[01:47:41]

Item Description

o Check/uncheck to show/hide the session

First parameter selected (left side axis)

_-——— Second parameter selected (right side axis)

e/ [01:47:41]
Remove
v Demo Subject 4 Soccer FI Remove All Sessions I]r [01:47:39]

Demo Subject 5 Soccer Practice / [22 Mar 2012/ 11:36:08] / [01:47:41]

v | Demo Subject 2 Soccer Practice / [22 Mar 2012/ 11:36:08] / [01:47:38]

= Click on a session to select
= Right-click selected session for Remove options

= Use the Clear Graph button to empty the legend and graph of all sessions

&
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Select time variables to populate the graph.

> Overview - Raw Physioclogical
| Heart Rate

Breathing Rate
Skin Temperature
Hear Rate Varability

- Dependent Physiclogical
> Summary Graphs Estimated Cora Temperature

> Sessions

> Subsessions

> Graph Types

> Graph Functions Heart Rate Percent
> Print / Export Heart Rate atAT

Heart Rate Recovery at 3lsern
> Data Filters

> GPS Data Select two variables.
> Readiness « 1stvariable selected = left axis, solid trace.
ANALYSIS IMPACT . . .
PROCESSING = 2ndvariable selected =right axis, dashed trace = = = = = ==
ANALYSIS REPORTS :
2 3.4
LOG DATA s :
OMNISENSE™ WEB PORTAL 33;3 e
~ 180 e s
OMNISENSE™ MOBILE & a0 J~/’ Z
£ 150 1.8 5
OMNISENSE™ TOOLS Ry — 1%
BASELINE FITNESS TESTING L ‘fJW T e e i iRt
FITNESS PARAMETERS e ; o
S50 X 0.2
APPENDICES i ® -
u’&hg Q““‘a ““:e
EULA
SUPPORT = If Treadmill Test, Beep Test or ROG Status is selected, heart rate, breathing
INDEX rate & activity level will automatically display, with a legend identifying them.
No other variables can be selected.
-Assessments
| Treadmill Test
BeepTest
40 Yard Dash Test
Jump Test
Jump Time in Air
Jump Height
ROG Alert Status
— Breathing Rate (BPM) — Heart Rate (BPM) = Activity (VMU)
80 240
:: 220

Breathing Rate (BPM)
=
&

(da) 238 Heay

Note

If a variable is de-selected, any remaining variable will display against the left
axis.
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Select Summary Variables

Select summary variables to populate the graph.

- Raw Physiolegical  pax Min  Avg  Tot Sum
Heart Rate

Breathing Rate

Skin Temp

Heart Rate Variability

- Dependent Max Min Avg Tot Sum
Estimated Caore

HR atAT

HR Recovery 30s

HR Recovery 60s

HR Recovery 120s

HR Recovery 180s

- Accelerometry Mav  Min  dun  Tat  Snm

Select two variables. Maximum, Minimum, Average, Total and Summary
are available according to context.

-
&80
o
o
=
o
D
o
D

5

179

Heart Rate Max (BPM)
() awg aspaaxa eIl

A [ suvject 02 Demo Soccer Practice /[23 Mar 2001- 11:36:081/ [01:47:38] |
B || Subject 03 Demo Soccer Practice /[23 Har 2001 - 11:36:07)/ [01:47:41]  J
C || subject 04 Demo Soccer Practice / [23 Mar 2001- 1136:081/ [01:47:39] K

The columns are labelled A = P to correspond the Legend entries. As for line
graphs, separate subjects will be colored differently.

1st variable selected = left axis, solid fill
2nd Variable selected = right axis, dashed fill

As there is no vertical cursor, the value of each bar is shown as a call out
above the bar :

If all sessions are from the same subject, then they will be colored
identically.

Subjed 01 Deme Lap (10906 = 122815/ 00 1507
Sutyect 01 Dama Lap F[TAZ3 10 = 14413401100 7018

A B cuneci 01 Dame Start Las 130 051 = 1023:27) 1002236
B

c

o Subgect 1 Dama Lap 153638 = M558/ 0NN

R -

Note

If a variable is deselected, any remaining variables will display against the left
axis.
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Max/Min/Avg

Maximum, minimum and average values for a given parameter and session are
calculated each time the parameter is selected.

> Overview

172 172

> Sessions

> Subsessions 160

> Graph Types

> Time Graphs

> Graph Functions
> Print / Export

> Data Filters

Heart Rate (BPM) Max, Avg

> GPS Data 40
> Readiness :E
ANALYSIS IMPACT v
PROCESSING ¢ . o
ANALYSIS REPORTS
LOG DATA = Max/Min/Avg values are available for parameters which are recorded

OMNISENSE™ WEB PORTAL perlodlcally. duringa s.essmn (such as heart rate, actlv.lty level). If the
parameter is cumulative, such as the number of calories burned, or the total
OMNISENSE™ MOBILE . .
number of steps detected, then max/min/avg values have no meaning, and
OMNISENSE™ TOOLS they are not available.

BASELINE FITNESS TESTING * Ifthe two parameters selected have the same units (e.g. Max & Avg Heart
FITNESS PARAMETERS Rate, as above, then they both display against the left axis. The axis title will
APPENDICES indicate which summary variables are displayed.

EULA Negative Values

SUPPORT Two parameters - Posture and Peak Magnitude Theta impact angle, may

INDEX report negative values. If paired with a positive value on the chart, then the
results may look initially confusing.

180

Peak Magnitude Theta Min, Max

Peak Magnitude Theta Min & Max.

= Minimum s a negative value, maximum is positive.
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Total values display exactly as max/min/avg, but are only relevant for some
parameters; various impact counts, workout loads and distance travelled.

> Overview
N, = Total values can be graphed simultaneously with max/min/avg values.

> Subsessions 154

139

> Graph Types 150 ==
140
> Time Graphs 130

132

120

o 448
> Graph Functions 100 417
90
80

70

> Print / Export

> Data Filters

peoT [ea1bojalshyd

0
50
40

Heart Rate Ava (EPM)

> GPS Data

> Readiness 0

ANALYSIS IMPACT 2
PROCESSING iL

ANALYSIS REPORTS " ° ¢ °
. Subject 02 Demo Soccer Practice / [23 Mar 2001 - 11:36:08]/ [01:47:38]

LOG DATA
. Subject 03 Demo Soccer Practice / [23 Mar 2001 - 11:36:07)/[01:47.41]

A
B
oMleENSETM WEB PORTAL C . Subject 04 Demo Soccer Practice /[23 Mar 2001 - 11:36:08] / [01:47:39]
D
=

. Subject 05 Demo Soccer Practice / [23 Mar 2001 - 11:36:08]/[01:47.41]

Er X e —

OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING

FITNESS PARAMETERS Stacked Total Charts
APPENDICES

Average Heart Rate compared to Total Physiological Load.

In the Workout Summary parameter category, four parameters display
EULA as a stacked bar chart. These charts cannot be displayed against a second
SUPPORT parameter.

INDEX Timein HR Zones

00:15:00
00:18:00
00:17:00
00:16:00
00:15:00

v/ MMl Zone 85-100%
v [ Zone 65-84%
v I Zone 0-64%

00:09:00
00:08:00
00:07:00
00:06:00
00:05:00
00:04:00
00:03:00
00:02:00
00:01:00
00:00:00

Tirme (HH:mm:ss)

»

= Individual zones in the legend can be checked or unchecked to include or
exclude them from the graph.

= The zone thresholds are fixed at 0-64/65-84/85-100 Subject HR max, and
not related to Safety Thresholds or Training Zones
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00:19:00
00:18:00
. 00:17:00
> Overview 00:16:00
00:15:00
00:14:00
00:13:00
00:12:00
00:11:00
00:10:00
00:08:00
00:08:00
00:07:00
00:06:00
00:05:00
00:04:00
00:03:00
00:02:00
00:01:00
00:00:00

> Print / Export »

> Sessions

> Subsessions

> Graph Types

Time (HH:mm:ss)

> Time Graphs

> Graph Functions

> Data Filt
e = Individual zones in the graph legend can be checked or unchecked to include

>GPSD
o2 or exclude them from the graph.

> Readiness

i - . M
ANALYSIS IMPACT Training Zone thresholds are common to both OmniSense™ Live and

PROCESSING OmniSense™ Analysis. They can be configured from Preferences > Training
ANALYSIS REPORTS Zones in either application.

LOG DATA s S— =
OMNISENSE™ WEB PORTAL e e T near i

OMNISENSE™ MOBILE IZ;_J | e

OMNISENSE™ TOOLS i |

BASELINE FITNESS TESTING — o et btk e e

FITNESS PARAMETERS Fovr i | 7oy s manine s v ot e

APPENDICES

EULA

SUPPORT

INDEX ) (e

= Threshold percentage values are global across all subjects, but local to the
subject’s own maximum heart rate, or heart rate at Anaerobic threshold,
depending on which is selected

® %HR@AT () %HR Max

= Lower thresholds for each zone can be edited. The upper threshold of the
adjacent zone will be updated automatically.
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> GPS Data

> Readiness

ANALYSIS IMPACT
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ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
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BASELINE FITNESS TESTING
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EULA

SUPPORT
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Summary Graphs (5/8)

Distance in Speed Zone

v B Zone 18 kph +
v Zone 14 - 18 kph
v Zone 11 - 14 kph
v/ Bl Zone 8- 11 kph
v/ Ml Zone 5 -8 kph
v/ Bl Zone 0 -5 kph

6.5

5.5

a5

3.5

Distance (km)

2.5

15

0.5

I
*

= Speed zone data is available in any session with GPS data.

= Individual zones in the graph legend can be checked or unchecked to include
or exclude them from the graph.

= Speed Zone thresholds are common to both OmniSense™ Live and
OmniSense™ Analysis. They can be configured from Preferences > Speed
Zones in either application.

keh

koh
kh
kgh
keh

r cta spend
sales@zeptnrammwhee oo

Defnck

Save Cancal

= Lower thresholds for each zone can be edited. The upper threshold of the
adjacent zone will be updated automatically.

= Speed units can be metric or imperial; they are set from Preferences >
General Settings in Live or Analysis (shown).

5 Preterences ===]

Gener Apolcation Settrgs

Sesion From/ T Durstion ays) 12 Doy

[Senert ot |

Smosth Bed Locabon Dats

= [T IS
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SYSTEM OVERVIEW

SYSTEMSETUP Time in Speed Zone

LIVE OPERATIONS
T
e
v/l Zone 4.3 3.1 kph
v/l Zone 0 - 4.8 kph

HH:mm:s

00:15:00

> Graph Types =

Time.

> Time Graphs 00:10:00

00:05:00

> Graph Functions

00:30:00
> Overview 00:25:00
> Sessions
> Subsessions E
]
-
v.

00:00:00

> Print / Export

> Data Filters

= Speed zone datais available in any session with GPS data.
> GPS Data

> Pendliness = Individual zones in the graph legend can be checked or unchecked to include
ANALYSIS IMPACT or exclude them from the graph.
PROCESSING . -
= Speed Zone thresholds are common to both OmniSense™ Live and
ANALYSIS REPORTS OmniSense™ Analysis. They can be configured from Preferences > Speed

LOG DATA Zones in either application.

OMNISENSE™ WEB PORTAL D preterences ==
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS

I kh- 7 keh

koh
L N3 kph
kgh
keh

Leas Than 42

Cenfigurable Speed Zones can be used when compatbie Dot GPg
unite ! sma and

APPENDICES
EULA
SUPPORT
INDEX

Defnck

= Lower thresholds for each zone can be edited. The upper threshold of the
adjacent zone will be updated automatically.

= Speed units can be metric or imperial; they are set from Preferences >
General Settings in Live or Analysis (shown).

5 Preterences ===]
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Summary charts are available for some impulse-related parameters, and speed
and elevation GPS data.

> Overview

> Sessions The format of the chart is a ‘box and whisker’ chart. This style of chart indicates
the range of values (minimum to maximum) and gives a graphic representation
of the distribution of values within that range.

> Subsessions

> Graph Types
> Time Graphs
5.5 e - vl A
2.8 vl &
> Graph Functions a6 vl ©
T : d E
> Print / Export £ v F
. Y
> Data Filters i
3
> GPS Data s 3.2 . % ‘
0 3
> Readiness g 28
s 26
ANALYSIS IMPACT e
PROCESSING 2 ==
1.8
ANALYSIS REPORTS I
A B c D E F
LOG DATA
A [ Subiect01Demo 5 bile Run /(16 Nov 2001 - 17:07:29]/(010028] (|
OMNISENSE™ WEB PORTAL B [ subiectol Demo 1sthile /[17:16:48 -> 17:24:48]1[00:08:01] J
C B subiect 01 Demo 2nd Mile /[17:24:50 > 17-20:50]/[00:05:00] K
OMNISENSE™ MOBILE D B subiect 01 Demo 3rd bile / [17:29:50 = 17:41:11)1 00:1:21] L
E B Subiecto1Demo 4in Mile /[17:41:12 > 17:47.06] 1[00:05:54] M
OMNISENSE™ TOOLS F [ Subiect01 Demo 5th Mile /[17:47:07 -> 17:53:52]/[00:06:45) N

BASELINE FITNESS TESTING
FITNESS PARAMETERS

Average Step Impulse Summary data

= Individual sessions in the graph legend can be checked or unchecked to
include or exclude them from the graph.

APPENDICES

EULA
SUPPORT
INDEX

Box and Whisker Chart Format

This diagram shows how this chart type represents the distribution of data
within a data set.

Maximum ——» —%—

98th percentile ——» ¥

91st percentile ———»%

T -4+—— 75th percentile
l: mean +—— 50th percentile (median)

+—— 25th percentile

4 Sth percentile ——

2nd percentile ——»
Minimum ———-%—

»

= Thefilled '‘box’ represents the spread of the middle 50% of the datain
the set, centered on the median, the most common value. The taller
the box, the more broadly the data is distributed between the maximum
and minimum values. If the box is shorter (as above), then the data set is
relatively more concentrated around the median value.

= An explanation of box plots, including the unusual upper and lower
percentiles, can be found at http://en.wikipedia/wiki/BoxPlot
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The scaling of the vertical axis in some of the bar charts can be customized in
Preferences > Summary Graph.

> Overview

q I Preferences
> Sessions ad =l

Summary Graph

| Summary Graph Custom Maximum
HRV (Min, Max, Avg) =

Speed @

Exercise Time |3

> Subsessions

‘ General Settings

> Graph Types

- |M km per hour
> Time Graphs [Trmining Zones |
Calories =
Physiclogical Load @
Mechanical Load |3

S
Print / Export Trairing Load =

> Data Filters

| Speed Zones

|
|
|
> Graph Functions | Bevation Zones |

‘ Data Fiters | Total Digtance Traveled =

(R —rr—— Physiclogicel Intensty |
> GPS Data ‘ Readness Weights | hysiclogical Intensity

. Mechanical Intensity | =
> Readiness

v
v
v
v
v
v
V| km
v
v
Training Intensty |2 Vi
v
v
v
v

ANALYSIS IMPACT Time in HR Zones hh:mm:ss)
PROCESSING Time in Training Zones (hh:mm:ss)
ANALYSlS REPORTS Time in Speed Zones (hh:mm:ss)
Distance in Speed Zones = km per hour
LOG DATA
OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE | Save | [ Cancel
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING = Thedefault setting is Automatic. This scales the vertical axis to show the
FITNESS PARAMETERS maximum value of all sessions at the full height of the axis. If a large outlier

value in one session reduces the relative height of all other bars, then

APPENDICES .
Automatic can be set manually to a lower value.

EULA
SUPPORT
INDEX
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Background Shading

When any time graph is displayed - excluding fitness tests - background color
can be set using the pull down list above the Time graph. Background color
options do not apply to Time graphs showing fitness test analyses, or
Summary graphs.

Background Shading

Mone -

ROG Subject Status

’ L
iy

-y
AL A LA Y

= Subject ROG Status is determined by the Safety Thresholds set in
Live Setup > Subject screen. Defaults are set in
Live > Preferences >Safety Thresholds.

E Preferences @

B
| 4 Default ROG Thresholds
| Activity Idle Timeout Red {seconds) 300
BR High Red (BFM) 35
| session Names | BR Low Red (BPM) 4

‘ General Seftings

‘ Markers

Core Temperature High Red 392
| Gauge Settings HR High Orange (% HRma) 0

HR High Red (% HRmax) 90
HR Low Red (BPM) 40

[Intersity & Load |

= ROG Status shows on the subject BioGauge, as the subject name panel
background color.

Impact 0.88 100% 100% 1289.6 Calories

%HR MAX 87
HR BR

160" 35

(D)

099{ Dennis Phillips R 1]
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> Overview

> Sessions
> Subsessions m
> Graph Types

> Time Graphs

> Summary Graphs

> Print / Export

> Data Filters

> GPS Data
N = Training Zones are related to subject HRmax or HR @ AT. They will correlate
closely to HR data, as seen above.
ANALYSIS IMPACT
PROCESSING = They can be configured in Live > Preferences > Training Zones
ANALYSIS REPORTS .
LOG DATA e S
OMNISENSE™ WEB PORTAL == 10 SHRGAT - 100 KHR Max
OMNISENSE™ MOBILE Sesson Nanes W0 [R5, FieAT
== % GHREAT - 99 WHREAT
OMNISENSE™ TOOLS — kit ks
BASELINE FITNESS TESTING ety oad LessThen 84 SHRGAT
— Custormizable Trasming Zones drrees the color of the bies n the Traning tab.
FITNESS PARAMETERS = o [} Metpimpretecpisispn ity e sk
IL‘""G_Z."'_“_‘ overraining and undertraming The default raming zones are set io
APPEN DICES Speed Zones industry accepted standards for u_mbl:. anaerobic. and high intensity
:om\s.based arcund an.md.-adual s h“tﬂ rale Bt Bnasrobs : &nelsr_m .
EULA Meskonss ST S S ol o ok i o Bl e
beep test) |
SUPPORT @ “HREAT SHR Ma Default
INDEX
Save Cancel
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Speed Zone background data will only display for sessions which incorporate
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> Overview
> Sessions * Sessions which contain no GPS data will display a non-colored background

> Sulerione if this optionis chosen.

> Graph Types
> Time Graphs

> Summary Graphs

> Print / Export

> Data Filters

> GPS Data
> Readiness :

ANALYSIS IMPACT ao » j“# . B !
PROCESSING il M A «‘r«»’*‘..w%?&.,-,_@;»“ A i
ANALYSIS REPORTS .
LOG DATA = Speed Zone thresholds can be configured in Live > Preferences > Speed
OMNISENSE™ WEB PORTAL Zones
OMNISENSE™ MOBILE T . s . —
OMNISENSE™ TOOLS i Spoed Zons
BASELINE FITNESS TESTING Hakers EEmEEA Mo bion s g I

P g Mg fHowr - 1099 Mée / Hour
FITNESS PARAMETERS e e 7 Ma/Hor - 830 Mia/Har
APPENDICES Satey T . | Speed Zone 3 | 5 Mie / Hour 659 Mie / Hour
EULA Pe—r—— 3 [ :u ::1 Mz / Hour

Training Thresholds | Soeed Zone 1.1 Less Than s Mie / Hour
SUPPORT e :

952 || [Configurabie Speed Zones can be used when compatible Blustooth GPS

INDEX e | [ S o aach o Far o kb connet

Workouts sales@zephyramywhere com

Defouit
Suve Cancal
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Cursor Values

Background Shading A i 1+
Hone = L )
Horizontal Axis Export
@ Real Time Elapsed Time

e 60 ©
180 — e J\\ e

Heart Rate (BPM)
B e @
& & &
J
1
{
w
S o
Wda) 1@y bupnpeasg

A o

o

AR AR
»e® i

q——r

# Description

Parameter Values at the location of the vertical cursor.

[HR] [BR] Selected parameters, first parameter on left-side vertical
axis.

hh:mm:ss Timestamp of vertical cursor location.
[00:03:54] Upper value elapsed time from start of session.

[14:05:55] Lower value absolute (real) time.

2 Click and drag the vertical cursor left or right to desired location.

Note

The default location of the cursor is in the center of the graph.
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Zoom
> Overview ------------------------------- """""""""""""""" i

> Subsessions

> Graph Types
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> Summary Graphs

> Print / Export

> Data Filters
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OMNISENSE™ MOBILE
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BASELINE FITNESS TESTING # Description

FITNESS PARAMETERS . .

1 Click and drag a box from top left to bottom right around the area to be
APPENDICES zoomed in. Multiple zoom-ins can be done successively.
EULA

Zoom Out

Click and drag the cursor from bottom right to top left - anywhere on
SUPPORT 2 | the graph - to zoom out. The zoom-out is always back to the graph's
INDEX original state, regardless of how many zoom-ins have occurred.

Pan

= Right-click and drag the graph in any direction. The vertical and horizontal
axis values will adjust automatically.
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Elapsed time is made available so that sessions which didn't happen
simultaneously in real time can be compared.
> Overview
> Sessions
> Subsessions 240
> Graph Types ﬁ:;
> Time Graphs E :: m&\'r"f‘ 1*1"' Y
> Summary Graphs 3‘1: Jj [ |
£ 100 ]
|
80 |
> Print / Export &0
> Data Filters * & o o o o
Lo W o W o
>GPS Data 0 i o o o o
> Readiness Horizontal Axis
ANALYSIS IMPACT © Real Time Elapsed Time
PROCESSING
ANALYSIS REPORTS * The example shows two non-consecutive laps of the same circuit. In real
LOG DATA time they don't overlap, so can't be compared directly.
OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS iy
BASELINE FITNESS TESTING i ) fﬂ'\{wmﬁm#?vwf—\fﬁh/h
FITNESS PARAMETERS L

APPENDICES

EULA [

SUPPORT w

5 5 3 ]
o " o o

INDEX L - =

Horizontal Axis
Real Time @ Elapsed Time

» Inelapsed time, both session Start Times are shifted to 00:00:00.

= IfElapsed Time data is exported from Analysis, the original timestamp
datais replaced with new timestamps starting at 00:00:00 for all sessions
exported.

@ Note

Two sessions could also be compared by adding an offset to the timestamp of
one - right click on the session in the Select Session pane and select Change
Time of Session from the context menu, but this will make the session time
change permanent.

103 Shift Sescionds) By Time o |

V| Charge Stat T To

Morday . December 03 2010 0X4305FM =

o Seemes Sessons
Fitered Sesnors
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= The full-screen button will display the graph contents in a separate, re-
sizable window.
> Overview
> Sessions — =
BR MR Act Detect AT Start tE
> Subsessions 02 180 098 R | P | T e _— '&
= Export
> Graph Types
e ——  Braathing P (B0 Ty —— 5
> Summary Graphs : ,23
200
80 — P o 150
> Print / Export Tss _ ::g T
S s = " 160 =
> Data Filters 245 \ e w
T e e ! 140 g
> GPS Data S eV ! il ) 130 2
i i /‘,\/ R P, [ 120 3
> Readiness i T oot AP M i
) e \b’" e B0
ANALYSIS IMPACT ;; | . 80
PROCESSING = et ool \ 1 o
- | LN M50
ANALYSIS REPORTS ; A
Y @ Rl o A &
LOG DATA i i o
OMNISENSE™ WEB PORTAL Toes (et)
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS « Zoom and Pan are still active in this window.
BASELINE FITNESS TESTING
FITNESS PARAMETERS = 5 |
APPENDICES
80
EULA 75
SUPPORT e
&0 =
INDEX s i
2 50 i 160 2
£ 150 &
2 4 g - 140
. A~ S sl
S - = 120 B
%50 - 7 \'/ Ar--110 2
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Print/Export(1/4)

Print Graph

= The Time or Summary graph will print exactly as displayedi.e. if zoomed-in

or panned.

HH:mmss HR BR

Background Shading
None b

= Alegend will be printed to identify sessions and parameters.

00:03:54 166 265 - . E
14:05:55 Horizontal Axis Export
@ Real Time Elapsed Time
]
240 | 80
' 75
220 i 70
]

200 4 B
o~ ! L 60 §
E 180 i A 55 &

] -
Q 160 "“fl \ 50 g
2 I 45 =
o '
& 140 - i 40 2
£ S
3 120 : =
: | =
100 =
'u\f R 1 25
80 ~ H 20
i 15
60 i 10
40 ! 5
o o
w® 3o
L b
AP A
pet pet
s Print Preview o e
| Printer: [Canon MP280 saries Printer o[ S |[ Bt || o ||
Page | Format
Oriertation
O Portrat
(3) Landscape
i [Ladi
Margins p- —
0 : gt e
e
0 ] ==
]
Margin Linits:
1/100kch = e

Demo Subject 3 Treadmill Test/ [18 Apr 2012/ 14:02:01]/ [00:11:51] Heart Rate (BPM)
------------ Demo Subject 3 Treadmill Test/ [18 Apr 2012 / 14:02:01]/ [00:11:51] Breathing Rate (BPM)

141



CONTENTS

ABOUT THIS MANUAL
GETTING STARTED
SYSTEM OVERVIEW
SYSTEM SETUP

LIVE OPERATIONS

> Overview
> Sessions

> Subsessions

> Graph Types

> Time Graphs
> Summary Graphs

> Graph Functions

> Data Filters
> GPS Data

> Readiness

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

OMNISENSE™ ANALYSIS OPERATIONS

Print/Export(2/4)
Export Graph Data
The contents of the graph can be exported in a number of formats.
C R ==
ced Time Map Active | Filter || Exporl|
To CSV
To Excel
Te JPEG
To GIF
Te PNG
To Tiff
_ To PDF
b —

= Select the preferred output format.

T |
Demo Subject 3 Treadmill Test (18 Apr 2012... e [ ) eSS
Csv

File Edit Format View Help
|pemo Subject 3 Treadmill Test / [18 Apr 201: .
1% % ¥

Y
|30/Apr /2015 12:00:00.000 AM 104 30/1
13A/ ame /AT E 130N ALNA Al 1An I
JPEG
GIF
PDF

TIFF

Note

Image files (jpeg, etc) show Session Markers on the graphs; .csv and .xIsx files
do not.
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SYSTEM OVERVIEW

SYSTEM SETUP

Export / Archive Session Data
LIVE OPERATIONS

Export to .ZSF File

> Overview ZSF (Zephyr™ Serial Format) files are used to migrate data from one

> Sessions OmniSense™ instance to another, or to archive large amounts of data outside
> Subsessions the database to speed up response time. The database will take longer to

> @yl Taes respond as it grows bigger.

> Time Graphs = Right click a session for a context menu.

> Summary Graphs

= Select Export to ZSF.
> Graph Functions
= Browse, name the .zsf file and save in your preferred location.

> Data Filters Select Session Drag Up to 16 onto Legend |
2 Zephyr
> GPS Data () Demo Subject 3 ‘
> Readiness & Deqos;:".e.,z W R
Treadmill T ¥ o
ANALYSIS IMPACT R hmsimbion Lo :
PROCESSING & ZEE‘ T;’W“'“ Tast Archive All Filtered Sessions To 25F
ANALYSIS REPORTS ) Denais Philips Delete
(D Treadmill Test Delete All Filtered Sessions
LOG DATA (D Treadmin Test Copy Sessions T »
Copy Subsessions To »
OMNISENSE™ WEB PORTAL cr:m Subsession
OMNISENSE™ MOBILE Move Session to Ancther Person »
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING » The .zsffile will contain all parameters for that subject and that session only.
- —] ~
FITNESS PARAMETERS S
5. )=/ ) « Omn.. » Analysis.. v [ 4]
APPENDICES e L
Organize v Share with = I ow il 7}

EULA
SUPPORT
INDEX

Documents library

Treadmill Test Demo Subject 3 18-April-2012.25f

@ Note

An exported session is not removed from the database.
Archive to .ZSF File

= Use the Filter Session panel to populate the Select Session panel with
only those sessions to be archived, and then select the Archive All Filtered
Sessions To ZSF option.

= Asingle .zsffile will be created which contains all the archived data. Name it
appropriately when saving.

= Archived sessions are removed from the database.

= Archived sessions can be re-imported to the database at any time using the
Import > From File toolbar button.

= Rl Al

From BioModule

i From File |:|

|
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Print/Export(4/4)

Import Session Data

Data can be imported into OmniSense™ as an external .zsf file. This file format
is the only means of importing external data, other than directly from a
BioModule.

1. Tolmport external data click on the Import button and select the From
File option from the list.

bl ki 18

From BH

From File

2. Browsetothe.zsffilelocation and select it.

Temp Subiect Live Sessins.st

Fie pame: = | Zupinyn Serialized File {"2sf)

3. ASelect Sessions dialog will display. Ifimporting an archived .zsf file
containing multiple sessions, then they will display as shown below.

i Select Sessions @
Import. Time Session Name Subject Mame {in import file) Exsts

28Nov-18 1145324 | Live Temp Subject

v 04-Dec-18 11:41:07 AM Live Temp Subject

v 04-Dec-18 11:50:27 AM Live Temp Subject

v 04-Dec-18 11:58:02 AM Live Temp Subject

v 04-Dec-18 12:06:34 PM Live Temp Subject

=

4. Check or uncheck the box in the Import column as desired. Each entry
contains the Time, Session Name and Subject Name of the original
session. If the subject already exists in the database, the Exists column
will be checked. If unchecked, a placeholder subject will be created in the
database. Select Import.

5.  Whenthe sessions have been imported, you will be prompted to refresh
the database.

Refresh Data 2

o) A new session has been added to database. Do you want to refresh data

[
now?

@ Note

Importing data does not automatically change the From and To entries in the
Filter Session List in order to display the imported sessions. If they contain
older data, you will have to manually change the From entry.
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Data Filters (1/2)

Filter Data

Data can be filtered for any graphed session, modifying what is displayed
according to multiple parameter values. Filters can be applied to 8 parameters
only, selected from the Filter Variable pull down list. 21 Threshold Variables
are available.

Examples
= Use Heart Rate Confidence to filter heart rate to remove excessively high

heart rate values caused by ECG noise, and interpolate - this will give more
realistic values for calories burned, intensity and load calculations.

Filter Variable Threshold Variable When Walue Action On/Cff
L |HR | - || Heart Rate Confidence | - || Less Than | - | 25 |Interpo|ate | - |

= Setrealistic upper limits for Speed from GPS data and set to null any values
greater than these, which may be outliers caused by poor GPS satellite
reception.

Fitter Variable Threshold Variable When Value Action On/Off

[~|Grater Than  [=[12  [nu B = |

L |Speed {mph) | - ||Speed {mph)

Action - Interpolate or Null?

Interpolate draws a straight line between points on either side of the
interpolated segment. Null sets no value; the graph trace will show a vertical
line either side of the null segment.

Choice of null or interpolate will depend on the scenario. The example below
shows the Subject 01 Demo Mountain Bike race available in Analysis (date
stamp 16 Sep 2001).

v
1
H

i ! 50
i ﬂ b e g

",

(%) SuapyanD 200y LK

P
a® .ﬁ'f@
o o

= Unfiltered data, showing HR (solid trace) vs. HR Confidence. HR Confidence
drops to zero soon after HR climbs above 200 beats per minute, most likely
caused by too-dry sensor pads. This rectifies itself eventually, as the
subject perspires.
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= The same data with action Interpolate, when HR Confidence < 25%

-} v 100 4
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= The same data with action Null when HR Confidence < 25%

= Inthe above scenario it would not be appropriate to set null HR values. The
user must decide whether unfiltered or interpolated data best represents
the subject’s actual HR. Interpolate is not ideal, but a better compromise
than null, or the original artificially high values.
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Data Filters (2/2)

Create a Data Filter

Data filters are saved within OmniSense™ Analysis and are applied to all
sessions unless disabled.

1. [Optional]l Set up a session or sessions in Analysis, together with the
parameters to be displayed.

2. Click on the Filter button above the graph. The text on the button is black
when no filters are active/On.

| Filter |

3. The Data Filters window will display.

| 5 it =)

Item Description

kP  Savedfilter
First column = New filter for editing (always available)

.# Edited but not saved filter

The variable to be filtered:
= HR Confidence

= HR
= BR
Filter Variable = Posture
= Activity
= Peak Acceleration
= HRV
= Speed

The variable which will determine filtering - 21

Threshold Variable available, not listed here.

= Lessthan

When = Greater than

= Equal

= Not Equal
Value The threshold value the condition applies to
Action Filter by interpolating or nullifying the filtered variable
On/Off Enable or Disable the filter

4. Editan existing filter or create new, and turn on or off as desired. Save the

changes.

5. When any filter is checked On, the button text is red and the filter
will apply to any graph displaying the Filter Variable, until it is set to Off.

Note

To save afiltered session permanently, right click on the session in the Select
Session tree, and select Save Filtered Session from the context menu.
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> Graph Types Select Session Drag Up to 16 ento Legend
. =27 Zephyr
> Time Graphs i..{:_| Subject 01 Demo
> Summary Graphs +@ maountain biking race /[16 Sep 2001 - 09:54:05]/[00:31:08] ( GPS )

+@ mountain biking race /[16 Sep 2001 - 12:04:10]/ [00:26:17] ( GPS )
+@ mountain biking race /[16 Sep 2001 - 14:22:16]/[00:19:43] ( GPS )

> Print / Export £8 6] mountain biking race /[16 Sep 2001 - P

> Data Filters +-{&) mountain biking race /[16 Sep 2001 - 20

> Graph Functions

Export To Z5F
| Export GPS Data To KML File
> Readiness Archive All Filtered Sessions To Z5F

Delete
ANALYSIS IMPACT : :
PROCESSING Delete All Filtered Sessions
ANALYSIS REPORTS A KML (Keyhole Markup Language) file will open in Google Earth™* if installed.
LOG DATA OmniSense™-generated .kml files also contain basic physiological data which

OMNISENSE™ WEB PORTAL can be viewed in the context of satellite or map view.

OMNISENSE™ MOBILE Export and Open Location Data

OMNISENSE™ TOOLS 1. Savethe kmlfile to a preferred location, and click to open.

BASELINE FITNESS TESTING : =8 EoR 2
=| |, iments\Exported OmnjSense b = | +- Search Exp... 0|
FITNESS PARAMETERS @) =[ ) mentseaported Omoisenses ~[ 43 ||
Organize « Share with = » i - i (7]

APPENDICES

| Subject 01 Demeo Mountain Biking Race 16 Sep 2001 .kml
EULA

SUPPORT

INDEX 2. Google Earth™* (if installed) will open. All built-in viewing functionality is
available, and the .kmil file will display in the Temporary Places node.

# Description

KML file in Temporary Places node.

1

2 | Slider control to move place mark around trace
3 | Path contained in kml file
4

Place mark showing current location according to slider control.
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> Graph Types Cut
> Time Graphs Copy

Delete

> Summary Graphs

Delete Contents

> Graph Functions Rename

> Print / Export Revert
y Save to My Places
> Data Filters
3
i | Save Place As... Y&
¥ Lavers Email...
> Readiness v B % primary Data Snapshot View
3L 'F Borders an
Sort A-7
ANALYSIS IMPACT Places -

PROCESSING Y05

ANALYSIS REPORTS 2. Achart will be inserted under the main satellite display. Above the chart
LOG DATA are selectable fields of GPS and BioModule data; Heart Rate, Activity and
OMNISENSE™ WEB PORTAL Peak Acceleration. Two of these may be selected for display on the chart.

251 ' P ation 0,03, 05 6.8

Elev G 0 i 20 ope 2!

OMNISENSE™ MOBILE

OMNISENSE™ TOOLS 3. Asthe mouse cursor is floated along the chart, a red arrow marker will
appear on the trace, with the selected parameters displaying beside it.
The same values will also display as call outs on the chart below.
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Readiness

@ Note

Overview

A subject’'s Readiness rating is a score on a scale of 1 - 10. The score is relative
for that subject, and is calculated algorithmically on two sets of factors.

Objective Factor - Orthostatic Hypotension Readiness Test

Subjects perform an orthostatic hypotension readiness test while wearing
a BioModule. The data can be transmitted Live to OmniSense™, via the
OmniSense™ mobile device application, or logged on the BioModule and
imported later.

Orthostatic Hypotension Readiness Test

The purpose of the test is to establish personal metrics which will contribute to

ameasure of Readiness.

= Resting Heart Rate

= Standing Heart Rate

= Resting Heart Rate Variability (HRV)

P .

>

| |

9 minutes 1 minute

1. Subject should lie down in a comfortable quiet location for 9 minutes.
They may be prompted earlier if using the mobile device application. This
establishes resting HR and HRV.

2. Subject stands and remains stationary for 1 minute. This will establish
standing HR.

If conducting an orthostatic hypotension readiness test using OmniSense™
Live, itis good practice to create a session name appropriate to this test, and
to name the session usingit, for easier retrieval of sessions in OmniSense™
Analysis

Subjective Factor - Readiness Survey

The subject must rate themselves on a 1-10 scale for eight points. Each rating
should be entered into a dialog window in OmniSense™ Analysis at the time of
analyzing the orthostatic test data, or directly in to the mobile application.

The factors are:

= Training Load = Current Stress
= Training Intensity = Eating habits

= Sleep Quality = Hydration level
= Overall Stress = Injury

When the survey is saved into OmniSense™, both the objective and subjective
factors are given weighted values in an algorithm, and a Readiness Score is
calculated. Weightings of each factor are configurable in Analysis Preferences.

Analysis of the test and survey results are described in the Baseline Fitness
Testing section.
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